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Follow Traffic Safety Instructions 
● Do not use the earphones while driving an automobile or riding a bicycle.  

It’s not only dangerous, but also against the law. 

● To avoid an accident, do not turn up the volume of the earphones too high while walking.

Protect your ears
● Do not turn up the volume too high. Doctors warn against prolonged exposure to high volume. 

● Stop using the device or turn the volume down if you have ringing in your ears.

● Follow local guidelines for waste disposal when discarding packages, batteries, 
and old electronic appliances.  

● Your player is packaged with cardboard, polyethylene etc., and do not use any unnecessary materials.  

● Ambient temperature : 5°C ~ 35°C (41°F ~ 95°F) 
● Humidity : 10 ~ 75%

Please read and understand all the instructions to avoid injury to yourself and damage to the device

REC
A↔B

Do not expose to extreme
temperatures (above 95°F
or below 23°F). Do not
expose to moisture. 

Do not apply excessive
pressure to the device.
Do not drop the player.

Do not try to disassemble
and repair the device
yourself. 

Do not expose to 
chemicals such as 
benzene and thinners. 

Do not expose to direct
sunlight or heat sources. 

Do not store in dusty
areas.

Do not let any foreign 
matter spill into the device. 

Do not place heavy
objects on top of the
device.

✽ Please be aware that we disclaim all responsibility for damages from loss of saved
or recorded data due to breakdown, repair or other causes.

Do not use the unit near 
any appliance that 
generates a strong 
magnetic field.

I Earphones 

I Ambient operating conditions 

I Environmental Information 
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!

!CAUTION
RISK OF ELECTRIC SHOCK. DO NOT OPEN

The uninsulated parts inside the charger could
cause electric shock.
For your safety, do not open the case of the
charger.

Read this User Manual to prevent any problems
that may occur while using the charger.

WWWWaaaarrrrnnnniiiinnnngggg
- Use the charger away from water sources to avoid fire or electric shock.

CCCCaaaauuuutttt iiiioooonnnn
- To avoid electric shock, use the charger only with a 120V power outlet.
- Make sure that the charger's plug is inserted all the way into the outlet.

A charger is supplied with your player.

Plug the charger into a wall outlet.

✻ When recharging is complete, 
“Full!” is shown in the display window.

✻ The first time the battery is charged, it will take 
approximately 4 hours.
Battery recharge time in normal operation is 
approximately 3 hours 30 minutes.

CCCCaaaauuuutttt iiiioooonnnn
- To avoid the risk of fire, do not charge longer than 12 hours.
- Do not plug several devices into the same outlet.
- Do not use a rechargeable battery or charger that is defective.
- When using the rechargeable battery for the first time or after several months of 

non-use, fully charge it first.
- Overcharging will reduce the battery life.
- The rechargeable battery is a consumable item and its capacity will decrease gradually.
- To prolong the life of your battery, use the fully charged battery until it is completely discharged, 

and then fully charge it again before use. If you charge the battery that is not completely drained, 
the battery operating time will decrease. In this case, fully cycle (fully charge and then fully discharge) 
the battery several times.

- Do not let metallic objects, such as necklaces or coins, come into contact with the terminals 
(metallic parts) of the charger and the built-in rechargeable battery. 
A fire or electric shock may result.

- Do not touch the charger with wet hands.

✍

✍

✍
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Mass Storage Device Support
● You can use the built-in 20GB hard drive to store your entire music library, 

plus use it as an external drive for your PC to store other data files.

MP3 & WMA Playback
● Your player supports playback of both MP3 and WMA. 

USB Host Function Support
● Connect a digital camera directly to the unit for easy transfer of music,

images and other data files without the need for a PC.

Image File Viewer 
● You can view JPEG images. Image files edited with Multimedia Studio can be 

viewed as slide shows.

Direct MP3 Recording
● You can convert music from CDs, cassettes, and radio into MP3 files without a PC.

USB 2.0 High Speed Data Transfer
● Maximum data speed transfer of 120 Mbps

SRS WOW Surround Sound 
● The 3D surround(SRS) feature adds spaciousness to the sound.

1.8-inch Color TFT LCD
● You can enjoy high quality images.

Upgradable
● You can upgrade the built-in programs when available.

Please check the home page (www.samsung.com) for upgrades.

Built-in Rechargeable Li-ion Battery
● The built-in rechargeable lithium battery provides up to 10 hours✻ of play time.
✻ Time may vary depending on usage pattern. 

E
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G

Features Features
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Location of Controls
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● The capacity of the useable built-in memory is less than indicated as the internal firmware uses a part 
of the memory as well.

● The appearance of the accessories shown is subject to change for product improvement without prior notice.

Model

Built-in memory

YH-925 GS

20GB

Mode indicator

Artist display

Track display
Elapsed track time

Album display

Remaining Time

Battery remaining indicator

Song number display

Next Track(Track Name) Indicator

Display

Player Earphones
AH30-00070D

Line-In Cable
AH39-00488A

User Manual
AH68-01655L

Charger
AH44-00061A

USB Cable
AH39-00655A

SELMENU

Belt Clip
AH61-01929A

USB Adapter
AH39-00658A

USB Host
Adapter

AH39-00733A

Installation CD
AH80-00099A

SELMENU

LINE-IN MIC HOLD

RE
C

MIC

HOLD switch

LINE IN jack

Skip/Search button

Skip/Search button

Record button

USB Cable Connection Port

Power On/Off
Play/Pause button

VOLUME UP/
SCROLL UP button

Earphone jack

VOLUME DOWN/
SCROLL DOWN button

SELECT button

MENU button

RESET Hole

Display
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Connecting the player to your PC

12

Continued...

2 Follow the instructions in the window to complete the installation.

Before connecting the player to PC, make sure to install
Driver&Utilities. If “Add New Hardware Wizard” appears,
press the [Cancel] button and install Driver&Utilities.

❑ System Requirements.

● Windows XP
● Windows Media Player 10.0

or higher
● Internet Explorer 6.0 or higher
● Pentium 200MHz or greater
● 50MB of available hard disk

space
● CD-ROM drive

(double speed or greater)
● USB port (2.0) supported
● DirectX 8.0 or above.

NNNNooootttteeee
- Log into your PC as an administrator

(Main User) and install the supplied
software (Driver & Utilities /
Napster Client / Multimedia Studio)
Otherwise, the software may not
install properly.

I Installing software

1 Insert the Installation CD into CD-ROM drive. 

The picture shown below appears. 
Select [Install Driver & Utilities].

✍
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Connecting the player to your PC
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GHow to check if USB driver is How to check if USB driver is 
properly installedproperly installed
Windows XP: 

1) Start → Settings → Control Panel →System →
Hardware →Device Manager →Disk Drives →
Samsung YH-925 USB Device

2) Start → Settings →Control Panel →System →
Hardware →Device Manager →Universal Serial Bus
Controller →YH-925 Mass Storage Device

7 When USB driver is not installed automatically, refer to next page.

3 Use the USB adapter to connect the USB cable to the USB port on your computer.

4 Connect the USB cable to the USB cable connection port on the player, 
and then plug the charger to the power outlet.
● If you disconnect the USB cable from your PC while implementing a command or

initializing during USB driver installation, your PC may not function correctly.

6 Upon installation of the USB driver "Samsung YH-925 USB Device" will appear
in the [System Properties] → [Device Manager].

5 The USB driver is installed with a message saying that it is searching for a
new device. You may not see the display screen during installation.
Go to the device manager to check that installation has been successfully completed.

I Connecting the player to your PC with a USB cable

Charger
Charger

USB Cable
USB 

Adapter

USB Cable

PlayerPC
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Manual Installation of the USB Driver

16

4 After selecting the driver and click [Reinstall driver].

5 Select [Install the software automatically] and click [Next]

to finish.

Go to “Transferring Music to Your Player”(p29) if the USB driver is installed.
Follow these steps if the USB driver is not installed :

1 Check the device manager.
● Windows XP (Professional):

Start → Settings → Control Panel →
System →Hardware →Device Manager 

2 Check if there is a device listed with an
exclamation point or a question mark 
(displayed as unknown device or USB
device). 

3 Double click on the device listed with an
exclamation point or a question mark.

I When an error occurs during installation of the USB driver

NNNNooootttt iiii cccceeee
- The installation method may vary depending on the type of PC or operating system

Contact your PC dealer or service center for installation information.
- If errors occur continuously when you install the USB driver, reconnect the USB cable after 

rebooting your system.

✍
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Formatting in PC
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1 Select [Start] → [Programs] →

[Samsung YH-925] in the desktop,
and then press [Recovery Utility].

2 Press the [Format Device] button.
When the format screen appears, select
the file system as FAT32 and then
press the [Start] button.

NNNNooootttteeee
- By formatting, all previously preset menus will be reset,and any pre-existing song or

data files will be erased.
- Care must be taken as formatted files can not be recovered.

● After completing the file transmission, you must disconnect the cable in the following way:

● Please close Multimedia Studio.

1 Double-click on the green arrow in the
taskbar on the bottom right of the window.

2 When the [ Stop a Hardware device ] message appears, 
press the [OK] button and disconnect the USB cable. 

✍
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Using Recovery Utilities

20 21

The Recovery Utility can be used to recover your system in the event the following occurs:
● If one of the messages below appears:

- The device firmware needs repairs. Please connect to PC and repair firmware with 
recovery utility. Device will be turned off.

- The device database needs repairs. Please connect to PC and rebuild database with 
recovery  utility. Device will be turned off.

● If the message "Loading" appears and the device does not operate when you turn on the power.
● If file search does not work properly in the Menu Library.

1 Connect the player to PC.

2 Select [Start] → [Programs] → [Samsung YH-925] in the desktop,
and then press [Recovery Utility].
● For more details on recovery, press [Help] to view the help.

3 Select the recovery method you want.

1 Connect the player to PC.

2 Right click on the Start button, then choose Explore to Open Windows
Explorer on PC.
● [Removable Disk] is displayed in Windows Explorer.

3 Select the file to save and drag-and-drop it into the
[Removable Disk] 

The Removable Disk can be used as Mass Storage. Video, audio and image files
can be downloaded but cannot be played back.

I Downloading files
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Installing the Napster Software

22

NNoottee
- If you are already a Napster member, 

click on the [I’m already registered] button 
in the upper right corner and sign in.

1 After you have completed the installation, create a member name and password.
Enter the required information and click [next].

2 Napster is free to search, browse, and play music clips.  If you want to become a
member of the Napster subscription service, enter your credit card information and
click on the [SUBMIT] button.  Note that you do not have to enter a credit card to
register.

3 Sign in to Napster. You can use Napster to copy your CDs to your PC and 
your player. You can search, browse, and play music clips in the Napster catalog.
You can buy songs and albums individually, or you can subscribe for unlimited 
access to the entire catalog of Napster content.  

✍

Before you install the Napster software, review the system requirements on page 12. 
If you don't already have Windows Media Player 10.0 or above, 
please go to http://www.microsoft.com/downloads and download it.

You will first need to install the Napster application:

1 Insert the installation CD that came with your player and follow the instructions 

to install Napster.

2 Follow the on-screen instructions as the InstallShield Wizard guides you through the
installation. When the installation has completed, click [Finish].
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Using Napster
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Here are some things you should know about tracks purchased on Napster:

● Tracks purchased on Napster are yours to keep and 

can be burned to CD and seamlessly transferred to your player.

● You can keep copies of purchased tracks on up to three computers. 

To copy your purchased tracks to another computer, use the [Sync/Restore]

feature on Napster available from the [My Account] menu.

NNoottee
- If you try to transfer to your player tracks that have not yet been purchased, 

you will automatically be prompted to purchase the tracks. 

✍

1 Insert the CD into the CD-Rom drive on your computer.

2 Launch the Napster application by double-clicking the Napster icon on your desktop.

3 Click the               [library] button to switch to the Library view, and select the 
CD icon. By default, all tracks are checked. If you don't want to rip the entire

CD, you can use the select all/deselect all buttons to change the selections.

4 You can initiate ripping in one of two ways:

a. Select the CD icon in the library tree and select Rip CD from the right-click menu to
rip the entire CD.

b. To rip some of the tracks, make sure the tracks you want are checked in the tracklist;
then click the Rip button, or select Rip Checked Tracks from the right-click menu.

NNNoottee
- Tracks are saved in the directory you specified for your Napster music.
- An optional MP3 encoder is available for download. You can access this encoder from

the “Update Napster” page of the My Account menu.
- If the MP3 encoder is installed the first time you rip a CD, you are prompted to set the

options for file type and quality. The default is 128 kbps WMA. Once you click [OK], 
the ripping process begins. You can change your ripping options later from the File, 
Options menu. 

Copying Tracks From A Music CD

I Searching for and Purchasing Music

✍

NNoottee
- If you do not have the Napster application, see page 22 for instructions on installing Napster.

✍
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26

You can use Napster to import existing WMA or MP3 files into your Napster library. 
Once these imported tracks are in your Napster Library, you can transfer them to 
your player.

NNoottee
- If you do not have the Napster subscription service and you attempt to import Napster tracks

sent to you by other Napster members, you will be prompted to either purchase the tracks or
sign up for the Napster subscription service. Any other protected WMA files will require that
you have the correct license for those tracks to import them into Napster.
If you purchase the tracks, you can burn them and transfer them to your player. 
If you sign up for the Napster subscription service, the imported tracks are treated as regular 
Napster downloads. 

To import WMAs or MP3s into your Napster Library :

1 Select [Import Track(s) to My Library] from the [File] drop-down 
menu on the Napster application. 

2 Browse to and select the directory where the tracks are located from 
the [Folder] window on the left. 

3 Select the particular tracks from the [Files] window on the right. 
To select multiple tracks, hold down the [Ctrl] or [Shift] keys while selecting, 
or click [select all].

I Importing Your Existing Music

✍

To search for and purchase music on Napster:

1 Launch the Napster application by double-clicking the Napster icon on your desktop.

NNoottee
- If you do not have the Napster application, see page 22 for instructions on installing Napster.

3 Select the track(s) you would like
to purchase. 

NNoottee
- You can also purchase an entire album by

clicking the provided [buy album] link or 
selecting a track on the album, right-clicking,
and choosing [Buy Album].

4 Click the [buy track] button, or 
right-click and choose [Buy Track(s)].

2 If there is a specific track you are looking for, simply type the artist, album, 
or track name in the search field in the upper right corner, select the search type
from the drop-down menu, and click [go]. If you do not know specifically what you
are looking for, you can go to the Browse tab to browse for music by genre.

5 A confirmation page with your selected tracks is displayed. Click [Next].

6 If it is your first track purchase and you are not a Premium service member,  
you will be prompted to enter your credit card information.

Once you purchase the track, the track is automatically downloaded to your Napster
Library. Next, drag and drop the selected MP3 files to the YH-925. Purchased tracks
can then be burned to CD and transferred to your player.

✍

✍
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28

Tracks that you purchase through Napster can be transferred seamlessly to 
your player using the Napster application. 

NNoottee
- Before transferring, make sure your player battery is charged or connected to AC power, 

otherwise your transfer may not complete successfully. 
- When you plug your device into your computer through the USB port, the Napster application

will automatically recognize it and display it as YH-925 under the menu tree of your 
Napster Library. 

- If your player is not connected or detected, it will display a “Portable Device” icon. 
- If your layer is not listed, check your connection and verify that the player is detected by 

your computer.

- If you try to transfer tracks to your player that you have not purchased yet, you will 
automatically be prompted to purchase the tracks.

- Make sure your player battery is charged or connected to AC power.

I Transferring Music to Your Player

✍

4 Click the [OK] button. 

5 A progress bar displays while the tracks are importing. 
When the tracks successfully imported, they will be stored and accessible 
from your Napster Library. You will also be prompted to edit the track 
data for any non-Napster tracks (see next section).
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3 The progress of the transfer displays under Transfer Status. To view transfer
status, click on the      in front of Samsung YH-925 under your Library to
expand the sub-folders, and then click on [Transfer Status].

4 When the tracks have finished transferring, the status is listed as Complete.

Important Note
Do not disconnect the device while the transfer is in progress. 

Windows XP
Click the "Safely Remove Hardware" icon on
your Windows taskbar and follow the instructions
in the message box that appears. 

5 Never unplug the device without first safely disconnecting. To safely 
disconnect or eject your player, do the following:

Windows XP

To transfer tracks from your Napster Library to your player:

1 Locate the track(s) that you want to transfer in your Library.

NNoottee
- You can transfer tracks from other areas of Napster by right-clicking and selecting

[Transfer Track(s) to Portable Device].

NNoottee
- If the tracks are Napster tracks that you have not already purchased, 

you will be prompted to purchase them. 

2 Click and hold the mouse on the track(s), then drag the tracks to the listed 
Samsung YH-925 icon in the left window of your Napster Library 
(refer to the following figure).

✍

✍
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3 The progress of the transfer displays under Transfer Status. To view transfer
status, click on the      in front of Samsung YH-925 under your Library to
expand the sub-folders, and then click on [Transfer Status].

4 When the tracks have finished transferring, the status is listed as Complete.

Important Note
Do not disconnect the device while the transfer is in progress. 

Windows XP
Click the "Safely Remove Hardware" icon on
your Windows taskbar and follow the instructions
in the message box that appears. 

5 Never unplug the device without first safely disconnecting. To safely 
disconnect or eject your player, do the following:

Windows XP

To transfer tracks from your Napster Library to your player:

1 Locate the track(s) that you want to transfer in your Library.

NNoottee
- You can transfer tracks from other areas of Napster by right-clicking and selecting

[Transfer Track(s) to Portable Device].

NNoottee
- If the tracks are Napster tracks that you have not already purchased, 

you will be prompted to purchase them. 

2 Click and hold the mouse on the track(s), then drag the tracks to the listed 
Samsung YH-925 icon in the left window of your Napster Library 
(refer to the following figure).

✍

✍
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32

Additional help for the Napster application is available by clicking on the          button
from any screen, or through the Help drop-down menu. 
The following help options are available:

● User Guide: Comprehensive online instructions for using all the Napster features and
functions

● FAQs: Answers to frequently asked questions about Napster

● Customer Support: If you require additional assistance using the Napster Software or
Napster Services, please contact Customer Support from the Help drop-down menu
or send your inquiries to support@napster.com(U.S.).

I Getting Help with Napster

To remove track(s) from your player:

1 Verify that your player is connected to your computer and displayed in your
Napster Library as Samsung YH-925. 

2 Navigate to and locate the track(s) within the player menu tree by clicking
on the      sign next to the YH925 icon.

3 Select the track(s) and click the [remove] button or press the [Delete] key on
your keyboard. 

I Deleting Music on Your Player
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Installing Multimedia Studio
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3 Follow the instructions in the window to complete the installation.
1 Insert the installation CD into the CD-ROM drive.

Select [Install Multimedia Studio].

2 Select language

● Multimedia Studio is a program that supports image editing, video playback and format
conversion, and multimedia album creation.
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Using Multimedia Studio
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GI Editing Images

1 Select the folder containing images to edit from the directory window at the
upper left-hand section of Multimedia Studio.
● The saved files will be displayed in the file list window on the right.

2 Select the image to edit.
● The selected image will be displayed in the [Preview image] window.

3 Press the [Edit Img] button.
● From the [Picture editor] window, you can perform functions like editing wallpaper images,

editing layers, inserting clip arts, making frames and other various editing functions.

NNNNooootttteeee
- Refer to Help for more information.

● Run Multimedia Studio from on the Desktop.

I Sending images

2 Select the image(s) to send to the player.

3 Select [File] → [Export images to device] at the top of the Multimedia Studio menu.

4 Select the device connected to PC from the [Select device] screen, and then
press the [OK] button.

1 Connect the player to PC.

● Files downloaded without using Multimedia Studio cannot be viewed on the screen.

✍
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Using Multimedia Studio
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I Making Albums for Slide Shows

2 Press the [Edit Alb] button at the top of Multimedia Studio.
● The [Making New Album] window will be displayed.

3 Select [Making Album for the use of PPL] and
then press the [OK] button.
● The [PPL Album] window will be displayed.

4 Press the [Add Image] button at the top of the [PPL Album] window to 
select the image to edit.
● If multiple images are selected, each image will be displayed for 5 seconds.

5 Press the [Add Music] button to add background music.
● Add BG Music: Images change every 5 seconds while the

selected music is played.

5 Set the size and path of the image at the [Resize images] window
and then click the [OK] button.
● The image will be sent to the selected device.

● The sent image can be viewed from [PhotoAlbum] → [Albums] on the player.

● The optimal image size for viewing on the unit is 160 x 128. Please adjust the image
size if the image does not display correctly on the player.

NNNNooootttteeee
- Path refers to the location or folder where the converted image(s) will be saved to on your PC.
- Image files saved in the player can be deleted by selecting [File] → [Delete images from device].
- Refer to Help for more information.

1 Connect the player to PC.

● Albums created from [Making Album for the use of PPL] can be viewed as slide shows 
on the player.

✍
NNNNooootttteeee
- To add a copyright protected audio file, which can be played on the player, 

select [Add Music] → [Add BG Music] → [Add from Device] and select the desired file on the 
connected player. 

- Copyright protected audio files added from the player are marked DEVICE, 
and cannot be played in the [PPL Album] window.

✍
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NNNNooootttteeee
- Select [Delete Album From Device] to delete ppl file saved in the player.

- Refer to [Help] for more detailed information 

I Capturing Video

1 Press the [Capture] button at the top of the Multimedia Studio menu.
● The Media Player screen will be displayed.

2 Click [Menu]→ [Open] on your PC and select the video to play.
● The selected video will be played.

7 Select the directory to save to in the save window
and press the [Save] button.
● The edited album will be saved in the selected directory.

8 Select [Album] → [Export] → [Export to Device] 
at the top of the [PPL Album] 
window to send the saved ppl file to the device.

9 Enter the album name at the [Select device] screen and then press the [OK] button.
● The ppl file will be sent to the selected device.
● The sent ppl file can be viewed from [PhotoAlbum] → [Slide Show] on the player.

6 Press the [Save] button at the top of the [PPL Album] window when album 
editing is complete.

✍

● The Multimedia Studio software allows you to capture a still frame from a video file and save it
as a picture, then transfer it to the YH-925.
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Run Multimedia Studio and press the Help button at the top of the
screen.
● Help will be displayed.

3 Press the     [Capture] button and then press the     [Capture] button when
the image you want to capture appears.
● The selected image will be captured.

4 Press the [Save] button.
● Save This captured image: saves the currently selected image.
● Save All captured images: saves all captured images.

5 Select the directory to save to from the [Save As] window and press
the [Save] button.
● The selected image will be saved.

NNNNooootttteeee
- Video playback and conversion codecs are not provided. It is recommended that you use

codecs of latest versions.
- Refer to [Help] for more detailed information
- The device will only play back still images. It will not play back video.

✍

1 2

1

2
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Activate             on the main unit.
● When you activate the HOLD switch, a "       " appears on the display.

Use the Hold feature to lock and disable all buttons. The Hold feature is useful to prevent your
Samsung player from being accidentally turned off or on when jogging, or to ensure
uninterrupted playback.

HOLD

I Starting Point
While playing a music file, press the SEL button at
the beginning of the loop you want to set.
● A ↔ appears in the display. 

Press the SEL button again to set the end of the loop.
● A ↔ B appears in the display. 

The loop is played repeatedly.

I Ending Point

NNNNooootttteeee
- Press the SEL button to cancel the loop.

NNNNooootttteeee
- Press and hold the SEL button in Now Playing mode while a file is playing to display the current Playlist.
- In the Playlist, use the SCROLL UP/SCROLL DOWN buttons to move to a track, and press the 

√» button to play the selected track.

I Playing Music

I Pausing Music

Turning Power On and Off
● Power On: Press and hold the √» button to turn on the power.
● Power Off: Press and hold the √» button to turn off the power.

Select Now Playing in the menu.
● Playback starts automatically.

Press the √» button to pause
playback.
● While in Pause mode, briefly press

√» again to resume playback.

Make sure the player is fully charged and the earphones are connected.

PLAY

Now playing

Press the VOLUME UP or DOWN button to
adjust the volume from 0 to 40.

I Adjusting the Volume

Loop Repeating

✍

✍

YH925AME INLAY  1/7/05 19:2912:0  Page 44



Searching Within Music Files

46 47

Menu Mode

E
N

G

Press the MENU button to switch to Menu mode.
● Use the SCROLL UP/SCROLL DOWN buttons to select the menu item you want, 

and then briefly press the SEL button.

NNNNooootttteeee
- In Menu mode, press the Menu button to exit from the submenu you are in.

● Now Playing: Display the song currently playing.
● Library: Search and select music to play.
● Photo Album: View saved image files or slide shows
● USB Host : Transfer files saved in the unit to external devices or transfer 

files saved in external devices to the unit.
● Settings: Change the settings.

NNNNooootttteeee
- VBR (Variable Bit Rate) File: An MP3 file that has varying compression ratios.
- When playing a VBR file, even if you press the         button within 5 seconds after the start of playback, 

the previous song may not be played.
- The actual play time and the time displayed on the main unit may differ for VBR files.

● During playback, press and hold the     ,        buttons to forward or reverse search the cur-
rently playing file.

I Searching for Specific Parts in PLAY Mode

● During playback, briefly press the         button to play the next track in the playlist.

● Press the         button within 5 seconds after playback starts to move to and play the 
previous track. Press the         button after 5 seconds to play the current track from the
beginning.

I Searching for Music Files in PLAY Mode.

● While in pause mode, press the     ,        buttons to move to the previous or next track in the
playlist and play it automatically.

I Searching for Music Files in PAUSE Mode.

✍

✍

Photo Album
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● Genres: Shows the song genre from the ID3 tag information stored in the music file.
● Press the √» button on the desired genre name. 

All song titles corresponding to the genre name will be played.
● If you select an genre name, song titles corresponding to that genre will be displayed. 

You can use the SCROLL UP/DOWN buttons to choose a song, and then press the 
SEL button to play the selected song.

● Tracks: Shows the song title from the ID3 tag information stored in the music file.
● You can use the SCROLL UP/DOWN buttons to move, and then press the SEL button 

to play the selected song.

In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select the Library, 
and  press the SEL button.

● Artists: Shows the artist name from the ID3 tag information stored in the music file. 
● Press the √» button on the desired artist name. 

All song titles corresponding to the artist name will be played.
● If you select an artist's name, song titles that correspond to the name will be displayed. 

You can use the SCROLL UP/DOWN buttons to move, and then press the SEL button 
to play the selected song.

● Albums: Shows the album title from the ID3 tag information stored in the music file.
● Press the √» button on the desired album name. 

All song titles corresponding to the album name will be played.
● If you select an album name, song titles corresponding to that album will be displayed. 

You can use the SCROLL UP/DOWN buttons to choose a song, 
and then press the SEL button to play the selected song.

I Searching for and Selecting Music Files

Artists

Library

Albums
Tracks
Genres
Playlists

Enya-Braveheart Theme

All Tracks

Jack Jhonson-Inaudible
Jhon Philip Sousa-US
My Heart Will Go On
Old Time Rock and Roll

All Tracks

Artists

Beach Boys
Beatles
Billy Joel
Bachman Turner Ove

Artists

Library

Albums
Tracks
Genres
Playlists

Turning the Tide

Everyday I Dream

Waking Up Is Easy
Every Dream

Albums

Building Birdages

Artists

Library

Albums
Tracks
Genres
Playlists

009 5tion-Sorry

Tracks

027 Cami-You can it
073 U-groove
015.everything me

Artists

Library

Albums
Tracks
Genres
Playlists

Blues

Genres

Other
Pop
Rock

Takin Care of Business

Blues

NNNNooootttteeee
- What is an ID3 Tag ?

This is what is attached to an MP3 to carry information relevant to the file,such as the title, artist,
album, year, genre and a comment field.

✍
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1 Select a title in the Playlists, and press and hold the SEL button.
● Move to Play Options screen.

2 In the Play Options, use the SCROLL UP/SCROLL DOWN buttons to select the
desired play option, and press the SEL button.

● Add To Mobile Playlist:
The selected title will be moved to Mobile Playlist.

● Cancel: Go back to the previous screen.

I Play Options (Playlists)

1 In the Library, use the SCROLL UP/SCROLL DOWN buttons to select Playlists
and then press the SELECT button.

2 Select the playlist that you want to play, and then press the SEL button.
● Saved files will appear in the selected playlist. 

I Selecting a Playlist

3 Press the SEL button on the desired file.
● The selected file will be played.

● Play: The selected title will be played.
If you select [Play] in Artist, Album and Genre, all titles corresponding to Artist, 
Album and Genre will be played.

● To Mobile Playlist: The selected track is added to the Portable Playlist.

● Cancel: Go back to the previous screen.

1 Select Artist, Album, Track, Genre, and press and hold the SEL button.
● Move to Play Options screen.

2 In the Play Options, use the SCROLL UP/SCROLL DOWN buttons to select the
desired play option, and press the SEL button.

I Play Options (Artist, Album, Tracks, Genres)

NNNNooootttteeee
- Mobile Playlist is a play list always present in the unit. Songs stored in the unit can be easily
added to or deleted from Mobile Playlist.

✍

Enya-Braveheart Theme

Tracks

Jack Jhonson-Inaudible
Jhon Philip Sousa-US
My Heart Will Go On
Old Time Rock and Roll

Play
Add To Mobile Playlist
Cancel

Artists

Library

Albums
Tracks
Genres
Playlists

Mobile Playlist

Playlists

Line-in Recordings
FM Radio Recordings

Clear tracks

Mobile Playlist

Jack Jhonson-Inaudible
Enya-Braveheart Theme

Enya-Braveheart Theme

Mobile Playlist

Add To Mobile Playlist
Cancel
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NNNNooootttteeee
- Even if you set the sampling and bit rates higher, voice recording will default to 8khz 32 kbps

1 Slide the REC switch up to start voice recording.

2 Slide the REC switch in the opposite direction that 
you had pushed for recording.
● Recording stops and the file is created.
● Files are recorded and renamed Voice0001.mp3, 

Voice0002.mp3, and so on.
● MP3 files are automatically added to your Library.

✍

Browsing Your Music

52

1 Select a Voice file in the Voice Recordings, and press and hold the SEL button.
● Move to Play Options screen.

2 In the Play Options, use the SCROLL UP/SCROLL DOWN buttons to select the
desired play option, and press the SEL button.

● Play : The selected title will be played.

● Delete : The selected title will be deleted.

● Cancel : Go back to the previous screen.

I Play Options (Voice Recordings)

1 In the Library, use the SCROLL UP/SCROLL DOWN buttons to select Voice
Recordings, and then press the SEL button.
● Recorded voice file will appear.

2 Press the √» button or SEL button on the desired file.
● The selected file will be played.

I Searching for and Selecting Voice Files

Albums

Library

Tracks
Genres
Playlists
Voice Recordings

Voice0001

Voice Recordings

Voice0002
Voice0003

Voice0001

Voice Recordings

Voice0002
Voice0003

Play

Delete
Cancel

Voice recordings
0001.mp3
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Viewing Image Files

NNNNooootttteeee
- Please refer to “Sending Images” under “Using Multimedia Studio” to send images to the player.

1 Press the MENU button.
In the Menu, select Photo Album and press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Albums.

3 Use the SCROLL UP/SCROLL DOWN buttons to move to the desired image
file and press the SEL button.
● The selected image file will be displayed.
● While viewing the image file, press the MENU button to move to the previous screen.

Albums

✍

Recording MP3s

1 While in Music mode, use the Line-In cable to connect the main unit's line in
jack and the line out jack of your external audio device.

NNNNooootttteeee
- If the battery is not sufficiently charged, the player will not completely encode the file.
- Adjust the volume of the external audio source to a suitable level and encode it.

If the volume level is too high, the sound quality may be poor.

LINE-IN MIC HOLD

2 Slide the REC switch to start recording.
● The music currently played on the external device will be saved as an MP3 file.

3 Slide the REC switch in the opposite direction to stop recording. 
● Recording stops and the file is created.
● Files are recorded and renamed Line-in0001.mp3, Line-in0002.mp3, and so on.
● MP3 files are automatically added to your Library.

✍

Your player can be to used to record directly from any external audio source such as a CD player,
cassette player, home stereo or radio.

Albums

Albums

Photo Album

Photo Album

Slide Show
Upload Album

¿Ωº∫≥Ï¿Ω

sky.jpg

Albums

sea.jpg
land.jpg
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Viewing Slide Show

56

1 Press the MENU button.
In the Menu, select Photo Album and press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Slide Show.

3 Use the SCROLL UP/SCROLL DOWN buttons to move to the desired file and
then press the SEL button.
● The selected slide show will be displayed.
● While viewing the slide show, press the SCROLL UP/SCROLL DOWN buttons 

to adjust the background music volume.
● While viewing the slide show, press the MENU button to move to the previous screen.

NNNNooootttteeee
- Slide show files can be created and edited in Multimedia Studio. 

For details, see “Using Multimedia Studio.”
- Music is played only if music was attached at the time of album editing.
- Select [Menu] ➔ [Photo Album] ➔ [Upload Album] to view image files transferred from external

devices to the unit.

✍

Albums

Photo Album

Slide Show
Upload Album

National Parks.ppl

Slide Show

Patriotic.ppl

1 Use the USB cable to connect the unit and the USB host adapter.
● Plug the charger into a wall outlet.

2 Use the external device's USB cable to connect the external device
and the USB host adapter.

3 Press the MENU button to switch to Menu screen. 
Select USB Host and then press the SEL button.

4 Use the SCROLL UP/SCROLL DOWN buttons to move to the 'Please connect a
slave device [YES]' and then press the SEL button.
● The External Device screen will be displayed.
● Make sure the External Device's Power is turned on before connecting it to your YH925.

I Connecting an External Device

Player

External USB Device

USB Cable (External Device)
USB Host Adapter

USB Cable (Player)

Charger

Please connect a 
slave device

YES
NO

Device

[MISC]
[The Volume SettingF
[VOICE]

√» Host

[DCIM]

You can transfer files back and forth between your YH925 and  a Digital Camera.

Photo Album
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1 At the External Device screen, move to a file to transfer to the Player.
● SCROLL UP/SCROLL DOWN : Moves up and down.

● SEL : Moves to a subfolder.

2 Press and hold the SEL button to bring up the pop-up window. Move to [Copy],
and press the SEL button.
● The selected file will be transferred to the unit. Do not disconnect the unit from the 

external device during file transfer.
● To view the transferred file, press the √» button to move to the Host screen and see the

[UPLOAD] folder.
● Uploaded image files can be viewed at [Menu] ➔ [Photo Album] ➔ [Upload Album].
● If you want to delete the selected file, move to [Delete] and press the SEL button.

I Transferring Files from an External Device to the Player

Do not disconnect
Device

Device

√» Host

[DCIM]
[MISC]
[The Volume SettingF
[VOICE]

[DCIM]

√» Host

[100NIKON]

[100NIKON]

DSCN1002.JPG
DSCN1003.JPG
DSCN1004.JPG

√» Host

DSCN1001.JPG

Copy

Delete
Cancel

1 At the External Device screen, press the √» button.
● The Host screen will be displayed.

2 Move to a file to transfer to the external device.
● SCROLL UP/SCROLL DOWN : Moves up and down.

● SEL : Moves to a subfolder.

3 Press and hold the SEL button to bring up the pop-up window. 
Move to [Copy], and press the SEL button.
● The selected file will be transferred to the external device.

Do not disconnect the unit from the external device during file transfer.
● If you want to delete the selected file, move to [Delete] and press the SEL button.

I Transferring Files from the Player to an External Device

Do not disconnect
Device

[My Music]

BrownEyes‚.mp3
GOD1.mp3
GOD2.mp3

√» Device

1TYM_OneLove.mp3

Copy

Delete

Cancel

Host

[tmp]
[UPLOAD]
[Program Files]

√» Device

[My Music]
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1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select
Settings, and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Repeat.

3 Press the SEL button to choose Repeat Off, One, All or Shuffle.
● Select the desired mode, and then press the MENU button to go to the main menu.

● Off: Select this to listen to songs in the current playlist one 
at a time in the given order.

● One (       ): Select this to repeatedly play just one track.

● All (       ): Select this to repeatedly play all tracks in the current playlist.

● Shuffle (       ): Select this to play all stored tracks in random order.

Settings

EQ-Off
SRS Settings
Record Settings
Backlight-5sec

Repeat-Off

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select
Settings, and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select EQ.

3 Press the SELECT button until the desired mode appears.
● Select the desired mode, and then press the MENU button

to go to the main menu.
Off ➔ Jazz ➔ Classical ➔ Pop ➔ Rock ➔ Bass boost ➔ 

WOW ➔ SRS ➔ TruBass

NNNNooootttteeee
- is a trademark of SRS Labs, Inc. 

WOW technology is incorporated under license from SRS labs, Inc..  
- Please adjust the volume to a suitable level, as the volume may increase in the SRS setting.
- This unit supports sampling frequencies of 32KHz, 44.1KHz or 48KHz.

● WOW: This feature allows you to enjoy the SRS and Trubass features simultaneously.

● SRS: You will hear 3D Stereo sound.

● TruBass: This is a bass boost feature that adds fullness to the sound.

✍

Settings

SRS Settings
Record Settings
Backlight-5sec

Repeat-Off
EQ-Off
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1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select
Settings, and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select SRS settings, 
and then press the SEL button.

3 Use the SCROLL UP/SCROLL DOWN buttons to select SRS Level, 
TruBass Level, Focus Level and Optimum, and then press the SEL button to
make the desired SRS Settings.
● Complete the desired setting, and then press the MENU button to go to the main menu.
● SRS, TruBass, Focus Level: The level for SRS, TruBas and Focus can each be set 

within the range of 0 to 10.
- Focus : You can enjoy clearer tone during playback.

● Optimum: It optimizes the SRS function according to the device connected.
Use the SEL button to move to the connected device.  
Earphone ➔ Headphone ➔ Speaker ➔ Carpack

NNNNooootttteeee
- SRS settings are available only if WOW, SRS, or TruBass are selected in the EQ menu

✍

Settings

Record Settings
Backlight-5sec

Repeat-Off
EQ-Off

SRS Settings

FocusLavel - 8
Optimum - Earphone

SRSLevel - 8
TruBassLavel - 8

SRS Settings

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select
Settings, and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Record Settings, 
and then press the SEL button.

3 Use the SCROLL UP/SCROLL DOWN buttons to select SamplingRate and Bit Rate,
and then briefly press the SEL button to make the desired recording setting.
● Complete the desired setting, and then press the MENU button to go to the main menu.
● Sampling Rate: Each time the Select button is pressed, the selection toggles  

between 32KHz and 44KHz.
● Bit Rate: Each time the Select button is pressed, the selection changes as follows: 

96 ➔ 128 ➔ 160Kbps.
● Selecting a higher bit rate results in better quality sound, but uses more memory space.

NNNNooootttteeee
- Voice can be recorded only at 8KHz 32kbps.

✍

Settings

Record Settings

Repeat-Off
EQ-Off

Record Settings

SamplingRate- 44khz

Bit Rate - 128kbps
SRS Settings

Backlight-5sec
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LCD Off Time Settings

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Contrast.

3 Press the SEL button until the desired screen 
contrast appears.
● The setting range of the contrast, which adjusts the contrast of

the screen, is 0 to 6.

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SELECT button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select LCD Off Time.

3 Press the SELECT button until the desired LCD power-off time appears.
● 30sec →1min →5min →10min →15min →Always
● If the selected time elapses while playing music, the screen switches to power save mode.

In power save mode, the music continues to play but the music information is not 
displayed on the screen. This helps to avoid battery drain.

● Press the √» button in power save mode to return to the normal playback screen.

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Backlight.

3 Press the SEL button until the desired Backlight
On-Time appears. 
● Off, 3, 5, 10, 15, 30seconds and Always are available for 

Backlight-On Time.

Contrast Settings

Settings

Record Settings

Repeat-Off
EQ-Off
SRS Settings

Backlight-5sec

Settings

Backlight-5sec

EQ-Off
SRS Settings
Record Settings

Contrast-3

Settings

Contrast-3

SRS Settings
Record Settings
Backlight-5sec

LCD OFF Time-30sec
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Power Off Settings

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Auto Power off.

3 Press the SEL button until the desired power-off time appears.
● Select the desired power-off time, and then press the MENU button to go to the main menu.

OFF ➔ 30sec ➔ 1min ➔ 5min ➔ 10min ➔ 15min.

Fader Effect

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Fader Effect, and then
press the SEL button.

3 Use the SCROLL UP/SCROLL DOWN buttons to select Fade Type, Curve Type,
and Duration Time, and then briefly press the SEL button.
● Complete the desired setting, and then press the MENU button to go to the main menu.
● Fade Type : Each time the SELECT button is pressed, the selection changes as follows :

- Fade Off: Music is played back at the volume level you set. 
- Fade In: Volume gradually increases only when playback starts.
- Fade Out: Volume gradually decreases at the end only.
- Fade In/Out: Volume gradually increases when playback starts and gradually 

decreases at the end.
● Curve Type : Each time the SELECT button is pressed, the selection changes as follows :

- Linear: The speed at which the volume of music increases or decreases is fixed. 
- Slow: The speed at which the volume of music increases or decreases is slow.
- Fast: The speed at which the volume of music increases or decreases is fast. 

● Duration Time : Each time the SELECT button is pressed, the selection changes as follows :
3 ➔ 5 ➔ 10 ➔ 15sec

Fader Effect

Fade Type-Off
Curve Type-Linear
Duration Time-5sec

Settings

LCD OFF Time-30sec

Record Settings
Backlight-5sec
Contrast-3

Fader Effect

Settings

Fader Effect

Backlight-5sec
Contrast-3
LCD OFF Time-30sec

Auto Power Off-5min
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Troubleshooting

One of the messages below appears:
“The device firmware needs repairs. Please connect to PC and repair firmware with recovery 
utility. Device will be turned off.” or “ The device database needs repairs. Please connect to PC 
and rebuild database with recovery  utility. Device will be turned off.”

The message "Loading" appears and the device does not operate when you turn on the
power.
File search does not work properly in the Menu Library.
● Refer to “Using Recovery Utilities”

The player doesn't work. There is nothing showing on the display panel.
● Reset the Player
● Connect the charger.
● Make sure the Hold switch is in the off position.

There is no sound even if I press the Play button in Music mode.
● Check if there are MP3 or WMA files on the player.
● Non-playable file formats (e.g. MPEG1 LAYER 1 file) cannot be played.
● Files that have been downloaded without using the Napster cannot be played.

I cannot download files.
●  Check the battery's power level.
●  Check if the driver is installed correctly on your PC.

Reinstall the software from the installation CD. 
●  Check the USB connection between the player and your PC.
●  Check if there is the “unplug/eject” or “Safely Remove Hardware” icon located in your icon tray

at the bottom of your screen.

Cannot view image files.
●  Files downloaded without using Multimedia Studio cannot be viewed on the screen.

2 Use the SCROLL UP/SCROLL DOWN buttons to select About, 
and then press the SEL\ button.
● If you select About, you can check the total number of tracks, total capacity, 

available capacity and software version information.

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

1 In the Menu, use the SCROLL UP/SCROLL DOWN buttons to select Settings, 
and then press the SEL button.

2 Use the SCROLL UP/SCROLL DOWN buttons to select Reset, 
and then press the SEL button.
● If you select YES, all selected settings will be restored to the default setting. 

Volume = 20
Repeat = Off
EQ = Off
Backlight = 5sec
Contrast = 3

Default Settings

Restoring Default Settings

Player Information

Reset all default
Settings?

NO
YES

Settings

Auto Power Off-5min

Contrast-3
LCD OFF Time-30sec
Fader Effect

Reset

Settings

Reset

LCD OFF Time-30sec
Fader Effect
Auto Power Off-5min

About

About

Tracks 127
18.6GB
18.4GB

0.23

Capacity
Available
Version
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Specifications

Model YH-925
Internal Memory Capacity 20GB

Built-in Rechargeable Battery Capacity 900mAh
Voltage 3.7V (Li-ion Rechargeable Battery)

Dimensions/Weight 1.96”X 0.54” X 3.47”/2.98oz
Case Aluminum/Plastic

File Transfer Speed Max. 120Mbps
Signal to Noise Ratio 85dB with 20KHz LPF(based on 1KHz OdB)

Earphone Jack Output Power 12mW(16Ω)
Output Frequency Range 22Hz~20KHz

Temperature Range -5~ +35°C(23~95F)

File Support
MPEG1/2/2.5 Layer3(8Kbps ~ 320Kbps, 8KHz ~ 48KHz)      
WMA (48Kbps ~ 192Kbps, 8KHz ~ 48KHz)

Troubleshooting

The Backlight is off.
● Please check the Backlight settings.
● Backlight is automatically disabled for longer playback in case of low battery power.

The playback time display during playback does not seem right.
● Check if you are not playing a VBR (Variable Bit Rate) file. VBR files are only partially supported.

The LCD window is too dark.
● Check the contrast in the Menu.
● Please check if the player is in power save mode.

During playback, some unknown characters are displayed on the display panel. 
● Unsupported languages will be indicated by an asterisk ( ✻ ).

A "/Noartist/Noalbum" file path appears on the playback screen in place of the 
selected music file's song title.
●  There is no ID3 tag information for the music file. Edit the song title, artist, and album 

information of the song.

It takes a long time when I search songs by Song Title, Artist, or Album.
● If there are many music files on your player, it may take longer to read them .

The product unit accompanying this user manual is licensed under certain intellectual property
rights of certain third parties. In particular, this product is licensed under the following US patents:
5,991,715, 5,740,317, 4,972,484, 5,214,678, 5,323,396, 5,539,829, 5,606,618, 5,530,655,
5,777,992, 6,289,308, 5,610,985, 5,481,643, 5,544,247, 5,960,037, 6,023,490, 5,878,080, and
under US Published Patent Application No. 2001-44713-A1.

This license is limited to private non-commercial use by end-user consumers for licensed
contents. No rights are granted for commercial use. The license does not cover any product unit
other than this product unit and the license does not extend to any unlicensed product unit or
process conforming to ISO/IEC 11172-3 or ISO/IEC 13818-3 used or sold in combination with
this product unit. The license only covers the use of this product unit to encode and/or decode
audio files conforming to the ISO/IEC 11172-3 or ISO/IEC 13818-3. No rights are granted under
this license for product features or functions that do not conform to the ISO/IEC 11172-3 or
ISO/IEC 13818-3.
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If this equipment does cause harmful interference
to radio or television reception, which can  be
determined by turning the equipment off and on,
the user is encouraged to try to correct the
interference by one or more of the following
measures:

◆ Reorient or relocate the receiving antenna. 

◆ Increase the separation between the equipment
and receiver.

◆ Connect the equipment to an outlet on a circuit
different from that to which the receiver is
connected.

◆ Consult the dealer or an experienced radio/TV
technician for help.

FCC
This device complies with part 15 of the FCC
Rules. Operation is subject to the following two
conditions: 

(1) This device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that
may cause undesired operation.

Caution: Any changes or modifications in 
construction of this device which are not
expressly approved by the party responsible for
compliance could void the user’s authority to
operate the equipment

Note: This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable
protection against harmful interference in a 
residential installation. This equipment generates,
uses and can radiate radio frequency energy and,
if not installed and used in accordance with the
instructions, may cause harmful interference to
radio communications, However, there is no
guarantee that interference will not occur in a
particular installation. 

FCC
Any changes or modifications not expressly
approved by the grantee of this device could
void the user’s authority to operate the device.

Compliance
This product conforms to the following 
Council Directive:  

◆ Directive 89/336/EEC, 92/31/EEC(EMC) 

Declaration of Conformity
Name: Samsung Electronics Co., Ltd
Address: 416, Maetan-3Dong, Paldal-Gu, Suwon
City, Kyungki-Do, Korea 442-742
declares under its sole responsibility that the
product
Trade Name: Samsung Electronics Co., Ltd
Model Number:  YH-925
has been tested according to the
FCC/CISPR22/95 requirements for Class B
devices and found compliant with the following
standards

EMI/EMC: AnSI C63.4 1992, FCC Part 15
Subpart B

This device complies with part 15 of the FCC
Rules.

Operation is subject to the following two 
conditions:

1.This device may not cause harmful 
interference, and

2.This device must accept any interference
received, including interference that may 
cause undesirable operation.

Party Responsible for Product Compliance

Samsung Electronics America
QA Lab.
3351 Michelson Dr. Suite #290
Irvine, CA92612
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Samsung warrants this product as free of
defects in material, design and workmanship
for a period of twelve(12) months from the
original date of purchase.

If during the period of warranty this product
proves defective under normal use and service,
you should return the product to the retailer
from whom it was originally purchased. The
liability of Samsung and its appointed
maintenance company is limited to the cost of
repair and/or replacement of the unit under
warranty. 
Return of the product for defective reasons
should be to the original purchaser; however,
Samsung Authorized Dealers and Authorized
Service Centers will comply with the warranty
on the terms issued to purchasers in the
country concerned. For further information
relating to the Authorized Service Centers
contact;
1-800-SAMSUNG (1-800-726-7864)
www.samsung.com

WARRANTY CONDITIONS:
1.The warranty is only valid when the warranty
card is properly completed, and upon presentation
of the proof of purchase consisting of original
invoice or sales slip confirmation, indicating the
date of purchase, dealer’s name, model, serial No.
and product number.
Samsung reserves the right to refuse warranty
service if this information has been removed or
changed after the original purchase of the product
from the dealer.

2.Samsung's obligations are to the repair of the
defective part, and at its discretion, replacement of
the product (service exchange unit).

3.Warranty repairs must be carried out by an
Authorized Samsung Dealer/Service Center. No
reimbursement will be made for repairs carried out
by non Samsung Centers, and warranty coverage
will not be valid for any repairs or damage caused
by such repairs.

4.Repair or replacement under the terms of this
warranty does not give right to extension to or a
new starting of the period of warranty. Repair or
direct replacement under the terms of this warranty
may be fulfilled with functionally equivalent service
exchange units.

5. The warranty is not applicable in cases
other than defects in material, design and
workmanship. The warranty does not cover
the following:

◆ Periodic checks, maintenance, repair and
replacement of parts due to normal wear and
tear.

◆ Abuse or misuse, including but not solely
limited to the failure to use this product for its
normal purposed or in accordance with
Samsung's instructions usage and
maintenance.

◆ Use of the product in conjunction with
accessories not approved by Samsung for
use with this product.

◆ Failure of the product arising from incorrect
installationor use not consistent with technical
or safety standardsin current force, or failure
to comply with productmanual instructions.

◆ Accidents, Acts of God or any cause
beyond the control of Samsung caused by
lightning, water, fire, public disturbances and
improper ventilation.

◆ Unauthorized modifications carried out for
the product to comply with local or national
technical standards in countries for which the
Samsung product was not originally designed.

◆ Repairs performed by non-authorized
service centers such as opening of the product
by a non-authorized person.

◆ The model, serial No. and product number
on the product has been altered, deleted,
removed or made illegible.

6. This warranty does not affect the
consumer’s statutory rights nor the consumers
rights against the dealer from their
purchase/sales agreement.
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THERE ARE NO EXPRESS WARRANTIES OTHER
THAN THOSE LISTED AND DESCRIBED ABOVE,
AND NO WARRANTIES WHETHER EXPRESS OR
IMPLIED,INCLUDING, BUT NOT LIMITED TO, ANY
IMPLIED WARRANTIES OF MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE,
SHALL APPLY AFTER THE EXPRESS
WARRANTY PERIODS STATED ABOVE, AND NO
OTHER EXPRESS WARRANTY OR GUARANTY
GIVEN BY ANY PERSON, FIRM OR
CORPORATION WITH RESPECT TO THIS
PRODUCT SHALL BE BINDING ON SAMSUNG,
SAMSUNG SHALL NOT BE LIABLE FOR LOSS OF
REVENUE OR PROFITS,FAILURE TO REALIZE
SAVINGS OR OTHER BENEFITS, OR ANY
OTHER SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES CAUSED BY THE
USE, MISUSE OR INABILITY TO USE THIS
PRODUCT, REGARDLESS OF THE LEGAL
THEORY ON WHICH THE CLAIM IS BASED, AND
EVEN IF SAMSUNG HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. NOR SHALL
RECOVERY OF ANY KIND AGAINST SAMSUNG
BE GREATER IN AMOUNT THAN THE
PURCHASE PRICE OF THE PRODUCT SOLD BY
SAMSUNG  AND CAUSING THE ALLEGED
DAMAGE. WITHOUT LIMITING THE FOREGOING,
PURCHASER 

ASSUMES ALL RISK AND LIABILITY FOR
LOSS, DAMAGE OR INJURY TO
PURCHASER AND PURCHASER’S
PROPERTY AND TO OTHERS AND THEIR
PROPERTY ARISING OUT OF THE USE,
MISUSE OR INABILITY TO USE THIS
PRODUCT SOLD BY SAMSUNG NOT
CAUSED DIRECTLY BY THE
NEGLIGENCE OF SAMSUNG. THIS
LIMITED WARRANTY SHALL NOT
EXTEND TO ANYONE OTHER THAN THE
ORIGINAL PURCHASER OF THIS
PRODUCT, IS NONTRANSFERABLE AND
STATES YOUR EXCLUSIVE REMEDY. 

Some states do not allow limitations on how
long an implied warranty lasts, or the
exclusion or limitation of incidental or
consequential damages, so the above
limitations or exclusions may not apply to
you. This warranty gives you specific legal
rights, and you may also have other rights
which vary from state to state.
This product is for personal use only, and is
only for use in compliance with the
limitations of copyright and other laws. 

To obtain warranty service, please contact
SAMSUNG at: 
Samsung Electronics America, Inc.
400 Valley Road, Suite 201 Mount Arlington,
NJ 07856
1-800-SAMSUNG (1-800-726-7864)
www.samsung.com
081299
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